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 It’s tough for me to provide step 1, step 2, and so on in a guide such as this, as I find when I get to one 

thing, it leads me to a tangent. That said, this guide is organized as I work, learn and teach – your style 

will likely differ. I hope you understand those places within where I suggest skipping ahead to such and 

such.  

Perhaps you’re one who reads the whole manual before installing the software. Perhaps you’ve been 

using Blackthorne Pro (BTPro) for a while and hoped to discover some different ways of looking at and 

using the application. You may be considering subscribing to BTPro but wanted to get an overview of it in these pages. Or you 

may have subscribed, installed, looked around, thought “Egads!” and got this guide so you could follow the steps of someone 

who proceeded you. 

 It is expected that you are an experienced eBay seller - that you know how to create your item title 

and descriptions, produce and host your photos or use eBay’s picture services, etc. You also know 

what shipping methods you want to use & where to find rates. Of course, you do know how to run 

your eBay business, with or without auction management software.  

 Please view the Table of Contents to get an idea of how this guide is arranged. It is based on the  

many, many times I’ve trained new Blackthorne users remotely. 

This is only a Quick Start Guide (with a few extra details). It is not a complete user manual for 

BTPro. Do not rely on this guide for every answer you’ll seek - the Blackthorne help site (reached 

through BTPro’s menu, Help>User Guide) and the Blackthorne Community Discussion Board on eBay 

(http://forums.ebay.com/db1/forum.jsp?forum=82) are sources of information for error handling and new & more advanced 

features of BTPro. The best sources of assistance for Blackthorne are the Blackthorne support team (under Help>Support) 

and the Blackthorne-hosted discussion forums (Help>Discussion Board). Each release of BTPro has fixes and/or new 

features, which are not necessarily addressed in this Guide.  

“QUICK START GUIDE???” you ask. “How come it’s so many pages?” Well – if you printed out Blackthorne’s User’s Guide to 

the tune of over 300 pages, it wouldn’t be obvious where to begin. There’s an awful lot of cool stuff in Blackthorne – and the 

more you know about it, the better tool it will be for you. BUT – if you really just want to get your first listing with Blackthorne on 

eBay (after your initial set up!), see Chapter 6 – This chapter lets you go for it, though that listing will take you longer to list 

than if you’d set things up properly before hand! 

I have not been sanctioned by eBay or Blackthorne to produce this guide – it is something I wanted to do for myself & my 

fellow BTPro users. I certainly have spent much time and effort to learn about BTPro and believe you will benefit from this 

information. I am not responsible for any loss of data you may have as a result of following my guide. Although I believe I’ve 

been accurate, we all know “stuff happens”. (That said, I never heard of any of the users of my Guide having any problems as 

a result of my guidance.) 

 BTPro is an application for SERIOUS SELLERS. It is not called “Easy Lister” or “Simple 

Seller”. BTPro will require an investment of time to study, understand and use effectively. 

However, BTPro has features to satisfy the newbie as well as the “geek”. Based on my 

experiences, I benefited from maintaining duplicate auction management systems for at least 

a couple weeks when switching from SAPro to BTPro, as you may if you’re currently using 

other software for listing or managing your eBay business. 
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Chapter 1 provides information for installing and setting up BTPro. Chapter 2 guides you in creating and submitting an item 

record. Chapter 3 describes handling running listings. Chapter 4 shows you what goes on with sales records. Chapter 5 is full 

of miscellaneous info which should be quite useful to you. Chapter 6 is a couple pages of a quick & dirty Quick Start – 

something I don’t recommend, as Blackthorne works better for you if you set it up correctly! 

Notes 

Italics text indicates menu paths, i.e.: File>Print means go to File, to Print.�

Bold  text indicates a ������  or 	���  you should click. 

Text in an outlined box indicates a note to read.  

Text in the Times New Roman font indicates steps to follow in creating the test auction in Chapter 2. 

Text in the Times New Roman  font & underlined indicates text to type as written. 

is something I think you should know at the point you’re at in the guide. 

 

is an idea you may want to use. 

 

The BTPro Concept 

BTPro separates the various characteristics of items listed and sold on eBay 

through a database* of many parts and maintains applicable relationships, for 

example, between an item, its listing record and its sale record. BTPro allows you 

to manage a broad view of your items, from pre-listing to post-sale. It is ideal for 

high-volume and business sellers, whether you list 10 items at a time or 10,000.  

One area of confusion to some new BTPro-ers is the use of various tabbed 

windows. The following are the tabbed windows in Blackthorne: 

·  Create Items – Create your item records & inventory information. This is 

the usual place then to submit your listing to eBay. 

·  Maintain Listings – Revise running listings, relist auctions, submit “similar” listings. 

·  Finalize Sales – Track your sales, send emails, print labels & reports, gather sales data. 

·  Buyers -  Contact information about your buyers. 
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·  Suppliers – Information about your suppliers (if you enter and keep such info). 

·  Consignors - Information about your consignment clients (if you enter and keep such info). 

NOTE: Think of your item creation in BTPro as having many relationships going on within 

that item. As you read this guide and use BTPro, you will find that your item has a 

relationship with an Ad Template, with an Item Template, with bidders & buyers, with your 

supplier, etc.�

�

There are 6 main areas of BTPro – Items, Listings, Sales, Buyers, Suppliers and Consignors. These relate to each other 

“deep”: in the database. Items contains all of your item records, whether they’ve been listed on eBay or not. Listings includes 

records of all items you have listed on eBay. Sales holds records of all items you’ve listed on eBay and which have closed with 

a sale or no bids at listing period end. Buyers includes all info you have about your high bidders. Suppliers contains data you 

have entered about your vendors. Consignors holds records you’ve created about your consignment clients. (Of course, if you 

have not entered info about your suppliers or consignors, there will be nothing in these areas.) 

�� A relational database is one which includes tables of data which link to each other. Imagine a file cabinet as the relational 

database. You have folders for toys, dolls and Barbie models. You can find Barbie info in toys or dolls, toy info can point to a 

specific Barbie doll and so on. Physically, the paperwork would be cumbersome to manage, but in a well-constructed 

database, the info can be easily cross-referenced.  

Some BTPro Hints  

There are a few features you should know about in BTPro: 

·  For you to be able to use BTPro, your computer should meet these system requirements: 

o 1.5GHz Intel Pentium Processor or equivalent  

o 512 MB RAM Minimum  (Many users experience speed issues at this, more memory is better.) 

o 50 MB free hard drive space  

o Windows NT, Windows 2000, Windows XP, Windows Vista 

o A screen resolution of 1024 x 768 is the minimum you should use with BTPro. 

·  You may double-click on the top title bar of a pop-up window to maximize it or to return it to the previous size it was. 

·  You may adjust column widths & row heights in the grid. See Chapter 3, Grids, for further information. 

·  You may not have worked with software previously which uses tabbed pages. A tab will look like this:.  
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·   Clicking on a tab in BTPro opens a new page with info or data entry fields. BTPro makes use of tabs in many areas. 

 

Navigation  

Following is a typical window in BTPro (this is the split view showing the grid on top, details below):  

 

A – Title bar – with name of software & BTPro current mode 

B – Menu bar – with dropdown menus to perform functions 

C – Tabs for various sections – Items, Listings, Sales, Buyers, Suppliers, Consignors 

D – Views – with folders & filters  

E – Search section – search for records in current filter which meets a condition you set (You may click on Advanced Search 

to expand the conditions) 

F – Quick Tips – features info about section or field which your mouse is above 

G – Action Toolbar – buttons perform specific functions 

H – Grid – Record data presented in rows & columns 

I – Quick Links – allows you to go to related info about selected record 

J – Details – Record data presented on a form 

K – Status Bar – Status messages appear here 
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Many of these sections can be dragged to another area or eliminated thru your settings. 

 

 

Acknowledgements  

My thanks to the eBay sellers /  Blackthorne users who proofread this & previous versions of this Quick Start Guide!  AND to 

the many BTPro beta testers and developers who posted to the BTPro bug board and helped me learn this software. You are 

all the finest examples of the eBay Community! 

 

There are some features in Create Items, Monitor Listings & Finalize Sales you should be aware of: 

·  In the Actions Menu, or by right-clicking on a record or by clicking on the icon between the grid & 
the details section, you can Go To associated records in another window. 

·  In the space between the grid & details view of the window, you should see something like this: 

 I’ve found 1000 rows per page to be the most you should 
have loaded into your computer’s memory without a noticeable slow-down of Blackthorne. If you will be working with 
more records, you may temporarily increase that number to do your work, but you will likely experience a slowing of 
Blackthorne while you do so. 

·  In the left sidebar, you will see folders or filters which have a plus sign (as 
in image to the right) in a small box on the left. You may click that plus box 
to expand the sub-filters under each such section. 
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This chapter takes you through the initial set up of BTPro before you add new or edit records.

������������� ������	���

Download Blackthorne from http://pages.ebay.com/blackthorne/pro.html. When the installation program is on your computer, 
double-click its icon to begin the installation. You’ll have to click a couple buttons to start the actual installation and within a 
couple minutes, you’ll see the B icon on your desktop & can open Blackthorne.  

����	���������������!�������!	� ���	"��

Every time you open Blackthorne, you’ll first see the “splash” screen for a minute or so. 

 

The first time Blackthorne opens, you’ll see this window. Click the Next>> button to begin entering your settings: 

 

You’ll first select the eBay site(s) to which you actually list. For example, if you’re registered as a seller only to eBay.com, 
check the first box EVEN if your listings show up on the other sites! 

 

After clicking Next>> on Sites, you’ll then enter your Seller Account information. Click the New… button, to open the Edit 
Seller Account window. 
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If you only sell under one eBay ID, enter your own info similarly to how I entered it as to left. 
Click OK and then enter the Seller Account Name in the window as shown below. 

 

If you sell under two or more IDs, click the New… button as in above/left image. Enter the 2nd 
(or subsequent) seller ID into the first field, do NOT check the “same as…” box, then enter the 
ID which has the subscription ot Blackthorne in the “Subscribed eBay User ID:” field. Enter that 
2nd or subsequent Business Name & Return Mailing Address in the appropriate fields.  

 

You’ll next be asked if you want to import your data from 
Turbo Lister, from eBay or not at all. If you have months or 
years of item records in Turbo Lister, you will likely want to 
import that. (If you choose this option, after you’re done 
setting up Blackthorne, you should go to 
File>Refresh>Refresh Activity and refresh ALL information 
for the previous two months.) 

If you import from eBay, all sales and listing data from the 
previous two months will be imported into Blackthorne. (eBay 
does not import data older than that.) If you’ve been listing to 
eBay directly or with another program, this will likely be the 
option you choose. 

If you’re brand new to selling, you obviously have no data to 
import and would choose the 3rd option. You may also have 
your item records data in a database or spreadsheet from 
which you created a CSV file and have no need of importing 
recent eBay data, so you may choose this 3rd option so you 
can later import that data thru a flat file. (See Chapter 5 
regarding flat file imports.) 

 

After clicking the Next>> button as in above image, an Authorization window will open: 

 

Your User ID will appear – enter your eBay password, then click on the Sign In  button, then the I agree button on the next 
window. Click the Done button after that. 

 

If you entered more than one Seller Account, you’ll go thru the same Authorization process for each account. 
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As you’ve done these things, Blackthorne will open two small status windows to import 
your data from eBay (if you chose that option) and will refresh/update the eBay 
categories – as seen to right. This may take 20 minutes or more. 

 

 

 

 

 

 

After the authorization, this Getting Started window will open: 

 

You’ll choose one of the three options; Start me off… Step-by-Step guide… -or- Let me fill out… myBlackthorne… -or- I’m 
pretty good… I prefer the second option, but do read below as you may prefer the Step-by-Step/first option – or you’re a geek 
& the third option is yours! 

�����	������������������������������

You’ll have 22 lessons to get you up to speed. Click the Next button after each lesson or select the step from the top field. 

      

Should you click Done or want to return to the Step-by-Step later, you can access it under Help: 
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Answer several questions (Click on the Yes button to change it to No & vice/versa): 

     

 

 

This will turn on the features you want to see. If you wish to later revise this, go to View>Features>Customize 
myBlackthorne… Much of this information is also under Tools>Options. That is the BEST place to define your settings. 

!�"#���	�������������

Don’t want to fiddle with myBlackthorne or the Step-by-Step? Fine! Just make sure you’ve created your settings correctly, 
know how to create an Item Template and the various presets and have it all handled! But you’re not seeing “this” or “that”? 
Go to View>Features>All and select All. 

Don’t want to fiddle with myBlackthorne or the created your settings correctly, know how to create an Item Template and the 
various settings? Choose this. 

 (This really isn’t just for geeks – if you set things up according to this guide, chances are you can choose “I’m pretty good...”!) 
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Whether you did all the Step-by-Step, myBlackthorne & other things when you first opened Blackthorne, you should confirm all 
your settings under Tools>Options. The following explains these. 

 

$����
�%&�����	�$����
�%�

  

 

You can manage up to five eBay IDs with your subscription to Blackthorne Pro. (I have 2 as 
seen above.) To the right is a sample of the settings for the primary subscriber. If you are 
editing the info for another ID rather than the one who’s subscribed to Blackthorne, 
uncheck the box for “same as eBay User ID” and enter the correct seller’s ID in the box 
below “same as…” as well as putting in that ID’s Business Name & Return Mailing 
Address. 

 

$����
�%&'�
�����$����
��

   

You do have to complete the email contact info for each of your selling IDs. Be 
sure to test your email connection on the first tab.  (Some experience issues 
with the email account, particularly if they use an online, free email service 
such as gmail or yahoo. Please search on the Blackthorne Boards 
(http://www.blackthornesw.com/cgi-bin/discus/discus.cgi) for info on settings – 
enter your search as in image to the right.) 

Notice the A-Z/Z-A button at the bottom right of most of these settings windows as seen to 
right. If you want your list of items in that window, you can click that button to put them in 
alphabetical or reverse alphabetical order. It does take about a minute for 100 items to be put 
in order, so do be patient if you use this feature. 
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$����
�%&
����	��(�%��

If you host your own photos, you should set up your picture host in 
Blackthorne. 

Your hosting service should be FTP-able and should have provided 
you with your user name & password. Enter those in the appropriate 
fields on the Edit Picture Host window as seen to the right. Enter your 
domain name (http:// not necessary here). Enter your full URL 
(including http:// in the Pictures Web Address field. Click the Test 
Connection  button to make sure your settings are correct thus far. 

Click the Browse…  button to select which sub-directory (folder) your 
eBay item photos will go into. (For some, this may be the / folder or 
/public_html folder.) 

 

I recommend using a 3rd party host for your 
photos for 2 reasons: 

1. If you pay eBay 15¢ each for more 
than 32 photos per month, it’ll be cheaper to go with one 
of the popular web hosts. You can host thousands of 
photos for a few bucks a month. 

2. You’ll have more control over the quality and size of your 
photos on your own web space. 

3. Blackthorne is known to experience issues with eBay 
Picture Services. 

 

��%�
�%%������&"
)�
��	��

If you are tracking your inventory levels in Blackthorne, you 
should choose your appropriate selection in this window and 
whether you wish to receive a warning if you’re about to list 
something for which Blackthorne’s records do not show 
enough in stock. 

 

��%�
�%%������&*�+�*�����

Enter the appropriate sales tax values for your state 
and/or city if you collect sales tax from your in-state 
customers 

 

 

 

 

 

 

 

��%�
�%%������&����%�

Only check the sites to which you list. If, for example, your listings show on 
eBay.CA or eBay.UK, but you are registered only on eBay.com, eBay.com is the 
only site you should have checked. 
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There are a few, most-frequently-used presets already 
populated here. If, however, you sometimes use a different 
combination of upgrades which are not listed, you should 
create these by clicking on the New… button & picking your 
upgrades appropriately. Of course, name your upgrade preset 
as something that is clear to you. 


	�%��%&
����
��
	�%��%�

You may want one, two or more payment presets depending 
on your own payment and returns policies. I have one which 
states I only accept PayPal (with my PayPal email address 
entered as seen to left). I have another which has the 
“Immediate payments required” box checked which I use on 
some fixed price items for which I want to be paid before the 
sale becomes “official”. 

Notice there are additional tabs in the Edit Payment window. 
Under Payment Instructions, you may note, for example, that 
payments are expected within three days of purchase. Under 
the Returns tab, you can choose to check the box for Returns 
Accepted and then the terms in the three fields. If you do not 
accept returns, leave that box un-checked but write out your 
“no returns accepted” policy in the larger field on this window. 

Please also complete the tabs for eBay Motors, ProStores and Giving Works if you use any of those services. 


	�%��%&������
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Shipping presets, though they may take a bit of time to create if 
you have many choices as I do, do make your work quicker as 
you enter your data into your item record. 

You do not have to set up every 
possible shipping preset (or any other 
preset) when you first start using 
Blackthorne. These can be created as 

you create your item record by clicking on the Edit  button 
to the right of the shipping preset field. 

Calculated shipping has become very popular with sellers over 
the last few years because you only have to enter the weight 
and dimensions of your package and eBay will compute what 
the buyer will pay. As someone who was selling on eBay before 
calculated shipping was available, I use flat shipping for most of 

my items as I had to develop my own charts way back when.  

The image to the left shows my Edit Shipping window for one of my Calculated 
shipping presets. I’ve added 75¢ for handling, which eBay adds into the actual 
postage charge before displaying the full amount to the shopper/buyer.  eBay 
requires us to enter our Domestic Handling Time on all items we sell – this is 
the time from when you receive a cleared payment to the time you take it to 
your carrier to ship. 

If you have shipping rules set up on eBay, you can apply each rule to your 
appropriate shipping preset. Choose the appropriate shipping rule’s profile 
name and your typical package size for this preset. 

The Blackthorne Users Guide (F1 when you’re in Blackthorne) has a bit more 
info on the shipping presets: just search on “shipping” and then click the 
shipping link which appears on the left of that window. 
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Blackthorne comes with four feedback messages which you 
can use, but you can add more as seen to right.  Because I 
don’t consider a transaction complete until my return period is 
up and I’ve left feedback for the buyer who’s left it for me, I 
have it checked at the bottom of this window to change the 
sales status to Successful when I leave feedback for the 
buyer. 
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If you sell items on consignment for others, creating 
any consignment plan you may use is done here. 
There are some more complicated plans I’ve seen 
which cannot be automatically configured using 
Blackthorne, but for plans most use, you can enter 
the details of those plans here. 

�

�

�

�

�

�

�


	�%��%&������
��/�%��
����
�
	�%��%�

The name “shipping destination” is a 
partial misnomer; in this preset, you set 
the locations you generally ship to as well 
as your own location and whether your 
items should be included in eBay’s 
distance-based search. (The distance 
search is generally used for items which 
are to be picked up by the buyer, such as 
large furnishings.) 

 

 

 

�

�
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With the Pro version of Blackthorne, you may create as 
many custom Ad Templates (AT) as you wish. (I have over 
100 in my list, as I test & keep every template I’ve designed 
for other sellers.) With the Basic version, you may only edit 
the Enhanced or Simple AT and can create no additional 
ones. Creating an Ad Template is covered in depth later in 
Chapter 5. 

 

 

 

 

 

 

*�������%&0�����*�������%�

Blackthorne comes with a few email templates, but you will 
have to edit them a bit to make them fully useful. You can 
also duplicate any of these or create new ones. (I find 
duplicating one which is close to what I want, then editing 
that, works better than starting from scratch.) 

When you click to edit an email template, the Email Studio 
opens. (“First Notification to High Bidder” email is second 
image to left.) At the bottom right of the Design View tab 
window is the Global AutoText (GAT) Section, which includes 
things you should edit: Payment Message & Signature. Click 
on Payment Message in the GAT section and replace the 
default text with your payment message. Do the same with 
the Signature. If you don’t want either of these, delete its tag 
(such as [[Payment Message]]) in the design window. 

You can also add or delete the Fields that are in the list to the 
top/right of the Email Studio Window. You may edit colors, 
sizes, etc. using the tools across the top. (These are 
explained in the later section about Ad Templates.) 

Leave the “Begin Repeat” and “Your total” sections alone – or 
be VERY careful when fiddling with them. You can safely 
delete a line such as “RepeatTotal([[AdjustmentFee]]) 
Adjustments” – BUT I recommend duplicating this template 
and fiddling with the duplicate so you can go back to the 
original if need be. 

When you’ve edited your template, you can click on the 
Preview tab to see how the email will look when you send it. 

Notice at the bottom of the Email Studio is a checkbox and 
field which you can set to change the sales status as 
appropriate to the email having been sent. 
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Want to send your buyers from the previous year a “Happy New Year” email? Duplicate one 
of the email templates, then edit it to remove what you don’t want and add what you do. Then, 
in the sales window, select all your buyers from the year you wish to send that email to. 
Select your New Year email and send to all at once. (Be aware, many email hosts do not 

allow you to send out bulk email – you may have to set the delay between emails to a few seconds or more in 
your Contact Account setting under the Advanced tab.  

 

*�������%&
	�
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Blackthorne comes with several printing forms and reports you 
may edit to fit how you do business. Please see the section in 
Chapter 5 for editing the Packing List, which can be used for 
editing the other Printing Templates. 

 

 

 

 

'�
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Check the 2nd choice ONLY if you wish to be 
notified of any beta-test versions which become 
available! 

 

'�

�����
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If you use Blackthorne on only one computer, choose the 
last option. If you and others will be using Blackthorne on 
a network, you will set the server or client as appropriate. 
Networking info can be found in the Users Guide (F1 in 
Blackthorne) – just do a search on the word NETWORK, 
then read the data about setting up and maintaining 
Blackthorne on your network. 
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I recommend checking all three square checkboxes so your 
database and other information is updated periodically behind the 
scenes. Set the time or leave “Any idle…” as you prefer. (The 
second square checkbox will import any listings you create 
outside of Blackthorne.)  
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These are set in the program to the default locations for the 
report, sound & flat file files, so if you move anything, re-set to 
the correct location. 

 

Run two eBay businesses and want to use 2 separate packing lists? Go to the Path to Report files on your 
computer & copy packinglist.rpx to a sub-folder named for your second eBay ID. When you need the 
packing list for the first ID, make sure your path is set to the original location. When you need it for the 
second ID, set the path to the location of that file. 
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If you use Endicia or UPS Worldship for postage and 
shipping labels, you can choose your label type for Endicia or 
the location of the Worldship XML import file in these 
sections.  

 

 

 

 

 

 

"
��	����&��
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If you wish the font size in the grid to be different than the 
default, set it here. Click to Show Row Numbers if you want the 
row numbers to show in the grid. And check the Double click 
box if you want the details window to open when you double 
click it on the grid. 

Under the Warning Dialogs, check those things you may want to 
see.  I suggest checking the last three as they are important 
notices to you. 

If you wish to read your questions received in My Messages in 
Blackthorne, check the box to display questions. You may reply 
to these questions thru Blackthorne rather than eBay if you wish. 

"
��	����&
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These choices may affect the speed of Blackthorne – though I’ve 
not found it to make any obvious difference.  

 

 

 

 

 

"
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En- or disable Blackthorne’s Spell Checker here. Choose to display 1 
or 2 tabs for the item details section. 
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These items affect your Create Items details window real estate: If 
you ever use a subtitle, that should be checked. If you have more 
than one seller account you’re managing in Blackthorne, display 
the seller selection dropdown. If you have more than one contact 
email address, check that. If you use part numbers for your items, 
check that option. 

"
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Set the height of your description window in the Item Details 
section as well as the font size for the description & its HTML 
view. If you use eBay’s themes, check that choice. If you use 
more than one Ad template, you’ll want that option checked. 

 

 

"
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If you use second eBay or store categories, check the 
appropriate box(es).  

 

eBay charges double the listing and upgrade fees for each listing in two eBay categories, 
but there is no extra charge for listing in two store categories. I advise listing in two of your 
store categories if your item fits into them, as there’s a greater chance your item will be 
seen by shoppers who browse thru your store cats. 

 

"
��	����&'	�����"���%&
����	�%�

There are two parts to this setting. First – Options: If you 
always use the same picture host (and HAVE set it in your Item 
Template(s), you do not have to display the Picture Host field. If 
you no not use eBay’s picture service, you do not need to 
display the Picture Options. Select from 1 to 12, the number of 
picture path fields you wish to show. (There is a scroll bar, so 
you can show fewer lines than you may have photos.) 

If you want Blackthorne to automatically remove item photos 
from your web space &/or computer, you can check the 
appropriate boxes.  

Under the Picture Studio tab, you can adjust your settings as 
appropriate if you will be using Blackthorne to edit the photos 
you’ll have on your listings. 

 

"
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Check the appropriate boxes for those features you may use for your 
listings. 

 

 

 

"
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If you will be using Calculated Shipping, you must display the 
weight and dimension fields to enter the appropriate numbers for 
each listing. 



 22 

 

"
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If you want these fields displayed in your Items details, check them. Since they 
display at the bottom and don’t really take up the valuable screen real estate 
nor are of interest to most sellers, whether you display them or not isn’t very 
important. 

�

�

"
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This field shows at the bottom of the Items details window. You may use it to 
keep notes to yourself about the item – this is not a field which is ever displayed to shoppers. 

 

.�
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If you want Blackthorne to play a sound when you receive a bid or 
make a sale, browse to the sound you want to hear. 

 

-�
���4������%&��
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Frankly, this is one window I tell others to leave as is because 
I’ve found it unimportant to my business and that of others I’ve 
trained. However, you may wish to uncheck all but the US 
shipping services if you only use US shipping so they don’t 
appear in your shipping services lists. 
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If you ever select the “Do not show again” option in one of the 
Reports dialog windows and you want to see it again, click the 
Reset the…  button here. 

 

/������%& �%��
��/�	����
�/������%�

If you generally list all of your Fixed Price items for GTC (Good Until Cancelled), set your 
duration default for that here. Set your usual auction and fixed price duration here. 
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Chapter 2 explains Item Templates and how to create items thru their submission to eBay.  

���"�&�"������

Before you create an item record, you should create your Item Template (IT). The IT holds default information which will be in 
all or many of your item records. (Do not confuse this with the Ad Template which is the layout of your item description, photos 
and other information you wish to display on your listing page.) 

 

If you’ve already created an item record, you can right-click it in the grid view & save as an IT, but you should then edit the IT 
fields so it only holds the default information which will be included in most or all item records you create from that. 

 

Item records & Item Templates hold all the same fields. The following instructions for creating an IT do apply to creating an 
item record for the most part. 

In the Create Items window, click on the Item Templates folder. (Notice I currently have 6 
ITs. Some users have only one, some have several; if you have 2 or more product lines 
which differ in many data fields, you may want to create an IT for each line. HOWEVER: 
Don’t get carried away!  You can always duplicate an item record which has the basic data 
for the new item you’re listing. ITs are to streamline the listing process – I’ve never noticed a 
seller who had a need for more than a dozen or so ITs at the most.) 

Next, click on the New Item icon near the top/middle of the window: 

  

Choose (Untitled) to create your first IT. 

My screenshots may show a layout different than yours; the details display differently 
depending on your monitor size & resolution. (I have a wide-screen monitor with 1680 x 
1050 pixels resolution.)  Also, you may have hidden some fields in your settings and they 
will not be visible in the details. I have the Item Details & Inventory in one “tab”, so you’ll 

not see the Inventory tab in my screen shots. 

Any entries you make to your IT can be edited in the item record! 

 

This tiny window will pop up – just click OK:  

 

Most fields are empty in the details section: 
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Note the Item Details section is closed below. Toggle a section open/closed by double-clicking its title bar. 

 

Here are my recommendations for entering your default info into each field: 

*�����

I title my ITs something like “GOing1nceLLC Design Item Template”. You may have a CD Item Template and a DVD item 
template, for example, if you sell those products. Notice, as you enter text into the title field, there is a counter above that field 
to let you know how many spaces you have remaining so you won’t be able to enter more than eBay’s limit of 55 characters 
(includes spaces & punctuation).  

���*�����

If you generally use the same subtitle for the items for which you’ll be using this IT, enter it here. (An observance I’ve made 
when doing searches: Mentioning free shipping in your subtitle is an unnecessary expense; Free Shipping is noted in the 
search results on eBay. It’s better to use the subtitle for something that will encourage shoppers to look at your listing, such as 
noting the benefits the buyer will receive by bidding on your item.) 

�����	�

If you have more than one selling account on eBay, you will want to select the seller of the items you’ll be using this IT for. 

'�
�����

If you have more than one selling account on eBay, you will want to select the contact account of the seller you’ll be using this 
IT for. 


�	��1����	�

If your part numbers always begin with “ABC” for example, you may want to enter that prefix here. Do be aware that you 
MUST edit the part number in your edit records, as you don’t want the same part number referencing 2 or more different items. 
The Blackthorne Users Guide states: “The part number field is used to identify the unique inventory item this item record is for. 
 If multiple items share the same part number, then the inventory will be shared by all those items.  If you leave the part 
number blank, it will be assumed to be its own unique inventory item.” 

/�%�	�����
�

You may enter your description (and applicable HTML) directly to the description field, or to the Edit window. Click on the Edit  
button to the right of the description field to open the WYSIWYG editor. As in the Design View tab of Ad & Email templates, 
there are tools to format your text, insert images and more. (These tools are explained later in this guide in the section about 
Ad Templates.) 

*�����

The Blackthorne subscriber account holder may use one of eBay’s Themes at no charge. Your other selling accounts will be 
charged to use a theme. A theme is a “picture frame” of sorts. 
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An ad template is the frame and layout of your listing description, which may include photos and graphics. Blackthorne has 2 
default Ad Templates (ATs), Simple and Enhanced. These are very basic. In Blackthorne Pro, you may add a custom layout, 
an AT, to display.  


����	�%�

There are both picture wells and picture path fields in this section. The 
easiest way to use photos in Blackthorne is to store them in a folder on 
your computer, then click on the picture well to choose the photo you 
want in that space. You may also drag and drop photos from the folder 
into the well, like this: 

 

Some sellers use their logo or another image for all of their first gallery pictures. In that case, put the photo into the first well of 
the IT, otherwise do not enter any photos in the IT. 


����	��(�%��

If you use eBay Picture Services for your item photos, select that. Otherwise, select your own picture host. In the case of ePS, 
your photos will be uploaded to eBay & you will be charged for each picture beyond the first unless your item is in a category 
which offers free eBay picture hosting. I think the better solution is to have a 3rd party picture host, such as pair.com or your 
own web site’s hosting. You then have control over the size & quality of your photos and can upload, edit or delete them when 
you want. 


����	��5����
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With ePS, you may choose one of the picture options. 

'�����	���

If you frequently use a specific category, even if only the first-level category, I recommend selecting a category in your IT. (If 
the 2nd level and so on differ, at least you’ll have the beginning of the category path in your item record.) To select a category, 
you can enter its category number in the first field, if you know that number, otherwise click the Select  button to the right of the 
category field to open the Category Selector.  In the sample below, I have chosen one complete path. Notice the blue sphere 
at the bottom/left of the selection window and the Next button at the bottom right. These indicate Item Specifics (IS) are 
available for that category. Click the Next button to open the Item Specifics window, then complete those IS as appropriate. 

 

There is also a field to enter your second eBay category if you so choose. (Remember, if you list an item in 2 eBay categories, 
your listing fees are doubled.) 
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In above image, you see that the button for Item Specifics (IS)  is highlighted. That 
means that for the eBay category you’ve selected, Item Specifics are available. 
Including your item’s IS is useful in getting a better Best Match ranking, so you 
should use them. Just click on the Item Specifics button to open the window in which 
you’ll select your IS.  

You may choose only one IS for each IS “category”. In the example to the right, for 
example, you may only choose Sign or Sticker, but cannot select both. If your IS is 
not included, Double-click on the line which states to and enter your own IS attribute. 

'�������������

For eBay Motors listings, you should use the Compatibility button to enter your item’s compatability/fitment details.  In the 
Blackthorne Users Guide, please search on “Specifying Compatibility Information” – this provides the details on entering that 
information. You can also use Catalog to populate this info, as in next paragraph. 

'��������

For eBay Motors listings, you may enter the catalog information eBay has available for many parts. Please see the section on 
the above-mentioned Users Guide page in the section, Specifying Compatibility Using eBay Catalog. 

The Catalog button is also used to enter info for DVDs, CDs and books. Please see “Entering Item Specifics & Catalog 
Information” in the Users Guide for additional information. 

'�
�����
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You must enter your item’s condition in most categories. This field is found 
below the first eBay Category field as pictured to the right. The conditions 
available may differ depending on your selected category. 

6�	�����
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If you offer items in different sizes, colors, etc., your category may support 
variations so that you can list variations of the same item in one listing. To enter 
your variations info, click on the Item Specifics button, then on the Variations tab. Please see “Creating Variations” in the 
Users Guide for details. 

 

���	��'�����	����

Choose the first store category in which your item should be. (Note, if the store categories you created in your eBay store do 
not all show up, go to Refresh>Update Seller Information to pull them in.) In your Item Template, it’s best to select your most 
frequently used store category. 

���	��'�����	����

You do not get charged extra to select a second store category, so if your item fits into a second store category, select it. 
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Select the listing format you most frequently use – Auction or  Fixed Price. 

/�	����
�

Choose the duration you most frequently use for the listing format. 

���	��
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If you most often list auction items at a price, such as $9.99, enter that here. If your prices are 
generally different, leave this at 0 so you’ll be unable to list without the price entered in your item record. This field is only for 
auction items. 

3�%�	)��
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Since, most likely, you rarely, if ever, use a reserve price on your auctions, I’d leave this at 0. 

�������1�2�7-�+��8�
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If your IT is for fixed price items & you have a particular amount you usually list these at, then enter that amount here. 
However, be aware that if you leave that amount in this field and do not correct it in the item record, you may list it at an 
undesirable price. This field is also used for the BIN amount on auctions. I’d leave it as 0 for the IT. 


	�)����

Private auctions are used to keep the buyer’s ID private by not posting the auction number or title in the buyer’s feedback. 

1�
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If you do charge sales tax, but not for the particular items you’ll use this IT for, check the Non-Taxable box. (For example, if 
you sell collectible gold coins and gold bullion, but your state requires sales tax on the coins – and this IT is one you’ll use for 
bullion, check this box.) 

���
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If you are listing multiples of the same item (or group of items) in a Dutch auction or fixed price, enter that quantity here. Of 
course, leave it at 1 for now unless you generally list a different quantity. 

 �����4��

Again, leave this at one in most instances for your IT. Do be aware that Lot Size is the amount of items in the group which you 
are selling for one particular price. For example, you may be selling a dozen eggs – in this case, the quantity is one, with a lot 
size of 12. 

 �%��
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Unless you generally use bold or another upgrade feature, leave this at None or Gallery. 
BECAUSE: if you put, for example, one of your listing upgrades which includes Featured 
Plus into the IT and forget to change it in the item record, you won’t be happy to see the 
listing fees! 

 


����
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Select the payment preset you most frequently use by selecting it when you click on the tiny down arrow. 
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If you don’t have a preset for this or other preset fields, you can create one at the time you 
are creating the item record. Click on the Edit  button to the right of the preset field. After 
entering your payment, returns & other info, choose one of the selections at the bottom/left 
of the edit window to change, update or create the item record or preset, as seen below: 

 

�
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Select the shipping preset you most frequently use. 

0%��������9������

If you use calculated shipping and have a common weight, enter that info into your IT. 
Otherwise, leave it blank until you edit the item record. 

/���
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If you use calculated shipping and have a common package size, enter that info into your IT. Otherwise, leave it blank until you 
edit the item record. 

/�%��
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Select your destination preset most commonly used 

 

 

These next fields are under the Inventory tab (as in above image), if you have 2 separate tabs for your item details.  

'�
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If this IT is generally used for client items, check the Consigned box. 

�������	�

If you generally list items from this IT which are from the same supplier, select that supplier’s name here. If you have the 
Consigned box checked, you’ll choose your client for whose items this IT will be used. 

'�%��

Unless your items generally cost you the same price, leave this blank in the IT so you can add the correct amount in your item 
record. 
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It’s unlikely you’ll have acquired inventory for which you’ll be using this IT on the same date, so leave this blank & enter the 
date acquired (if you wish) on the item record. 

*	����"
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If you generally have 10 items on hand (or 1) for items for which you’ll be using this IT, and you track inventory, check the 
track inventory box and enter the total on hand. 

 �2�"
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If you want to be notified when your inventory level reaches a particular quantity, enter that 
amount here. You’ll then be able to see records in the Items window’s Low Inventory filter. 

���	���� ������
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Obviously, you will not have the same storage location for all your items, so you won’t enter that data into the IT, but into the 
item record if you wish. 

1���%�

Obviously, you will not have the same notes for all your items, so you won’t enter that data into the IT, but into the item record 
if you wish. 

'�%����

If you have custom fields which hold the same data for the items for which you’ll use this IT, enter that data, otherwise leave 
this blank for now. 

"���������%�

These fields are generated by Blackthorne and may be ignored in the IT. 

 

����������"�%������

Before you create an item record, you should have created your Item Template (IT).  

In the Create Items window, click on the Item folder in which you want your item record to be placed. By default, the new item 
record will also appear in the All Items folder and in the New & Unlisted filter. 

To begin creating an item record, click on the New Item icon near the top/middle of the window: 

  

Choose the IT you wish to use for the default info in your item record. 

 

This tiny window will pop up – just click OK:  

 

 

 

Much of this has been described above in the Item Templates section. You will then edit all necessary fields: 

*�����

Enter the title of your item.  

���*�����

If you want to use a sub-title for this item, enter it here. Be aware, in most cases, eBay does charge you extra for using a sub-
title. 
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Select the seller of this item. 

'�
�����

Select the contact account of the seller for this item. 


�	��1����	�

If you use a part number for this item, enter it here. 

/�%�	�����
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Enter your item description here. 

*�����

If desired, choose the theme you want to display this item. 

$��*��������

If desired, choose the Ad Template you want to use for this item. 


����	�%�

Choose your photo(s) for this item. 


����	��(�%��

If your picture host is not selected, choose it here. 


����	��5����
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With ePS, you may choose one of the picture options. 

'�����	���

Select your eBay category here & enter Item Specifics. Please see Chapter 5 for information on entering Multiple Variations 
data for listings in which you’ll offer choices, such as color and size, to your shoppers. 
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In above image, you see that the button for Item Specifics (IS)  is highlighted. That 
means that for the eBay category you’ve selected, Item Specifics are available. 
Including your item’s IS is useful in getting a better Best Match ranking, so you 
should use them. Just click on the Item Specifics button to open the window in which 
you’ll select your IS.  

You may choose only one IS for each IS “category”. In the example to the right, for 
example, you may only choose Sign or Sticker, but cannot select both. If your IS is 
not included, Double-click on the line which states to and enter your own IS attribute. 
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For eBay Motors listings, you should use the Compatibility button to enter your item’s compatability/fitment details.  In the 
Blackthorne Users Guide, please search on “Specifying Compatibility Information” – this provides the details on entering that 
information. You can also use Catalog to populate this info, as in next paragraph. 

'��������

For eBay Motors listings, you may enter the catalog information eBay has available for many parts. Please see the section on 
the above-mentioned Users Guide page in the section, Specifying Compatibility Using eBay Catalog. 

The Catalog button is also used to enter info for DVDs, CDs and books. Please see “Entering Item Specifics & Catalog 
Information” in the Users Guide for additional information. 
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You must enter your item’s condition in most categories. This field is found 
below the first eBay Category field as pictured to the right. The conditions 
available may differ depending on your selected category. 

6�	�����
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If you offer items in different sizes, colors, etc., your category may support 
variations so that you can list variations of the same item in one listing. To enter 
your variations info, click on the Item Specifics button, then on the Variations tab. Please see “Creating Variations” in the 
Users Guide for details. 
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Choose the first store category in which your item should be.  

���	��'�����	����

You do not get charged extra to select a second store category, so if your item fits into a second 
store category, select it. 

 

 �%��
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Select the listing format for this item – Auction or Fixed Price. 
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Choose the duration for this item. 
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If this is an auction item, enter its starting price here. 
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If this is an auction item & you wish to have a reserve price on it, enter that amount here. 

�������1�2�7-�+��8�
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If your item is set up for an auction, you will enter its Buy it Now Price here, if you have one. If the listing format is fixed price, 
the field is called Fixed Price & you will enter it here. 


	�)����

Private auctions are used to keep the buyer’s ID private by not posting the auction number or title in the buyer’s feedback. 

1�
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If you do charge sales tax, but not for this particular item, check the Non-Taxable box. (For example, if you sell collectible gold 
coins and gold bullion, but your state requires sales tax on the coins, check this box.) 
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If you are listing multiples of the same item (or group of items) in a Dutch auction or  fixed price, enter that quantity here.  

 �����4��

Do be aware that Lot Size is the amount of items in the group which you are selling for one particular price. For example, you 
may be selling a dozen eggs – in this case, the quantity is one, with a lot size of 12. 
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Leave this at None or Gallery unless you want to use bold, highlight, featured plus or another 
upgrade feature. 
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Select the payment preset appropriate for this item. 
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Select the shipping preset you most frequently use. 

0%��������9������

If you use calculated shipping and have a common weight, enter that info into your IT. 
Otherwise, leave it blank until you edit the item record. 

/���
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If you use calculated shipping and have a common package size, enter that info into your IT. 
Otherwise, leave it blank until you edit the item record. 

/�%��
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Select your destination preset most commonly used 
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These next fields are under the Inventory tab, if you have 2 separate tabs for your item details.  
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If this record is for a client item, check the Consigned box. 
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Select the supplier or consignor’s name here. 

'�%��

Add the correct amount here, if desired. 

/����$�;��	���

Add the date you acquired this item, if desired. 
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If you track inventory, check the track inventory box and enter the total on hand. 
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If you want to be notified when your inventory level reaches a particular quantity, enter that 
amount here. You’ll then be able to see records in the Items window’s Low Inventory filter. 

���	���� ������
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Enter the storage location of this item here, if desired. 

1���%�

If you have any notes you wish to keep about this item, enter them here. These notes are for your own use only. I used to use 
this field to note quotes for shipping prices to countries I didn’t generally ship to when I received a question about that. 

'�%����

If you have custom fields you use for this item, enter their info here. To create a custom field, click on the Manage Custom 
Fields link in this section. You can create fields for Process (across items, sales, buyers, suppliers & consignors) or in just one 
area. You may have up to 10 custom fields if you use the Access database in Blackthorne or unlimited custom fields if you 
have a SQL database. See “Managing Custom Fields” in the Blackthorne Users Guide for more information. 

"���������%�

These fields are generated by Blackthorne. 


��"	��	���������"�������'�

When your item record is complete, you will then submit it to eBay. You may submit one or more 
records at a time. I strongly recommend using Submit with Preview at the top/right of the 
Blackthorne window for two main reasons:  

1. You will then see the listing fees to be charged & can cancel & fix your item record if 
needed, for example because you had 2 eBay categories selected rather than 1.  

2. If there is an error in your listing, you’ll be notified and can fix that rather than being 
surprised later. 

3. (Okay, I said 2, but…) You can review one last time how your listing will look. 

This opens the submission preview window.  The top of this 
window will list all items you’re submitting with the error field 
and fees fields. You may scroll thru any or all listings if desired. 
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When you’re ready to submit them, click the Submit or Submit All button at the bottom/right of the window: 

  

That opens the Submit Listings window. You may submit immediately, 
submit to eBay (for an extra fee) or schedule Blackthorne to submit it on 
the day & time you wish. 

I only “submit to eBay” if I’m going on vacation & may not have my 
computer on at the time I want to start the listings. 

I generally “schedule Blackthorne” and set my start time at a time 
Blackthorne will be running and connected to the internet, but it won’t be 
convenient for me to submit at that time. You can schedule the interval 
(days, hours & minutes – in that order!) as well as the listings per 
interval. In the image to the right, I’ve scheduled my listings to go up 2 
items per minute. 

If you have scheduled listings thru eBay or Blackthorne, those records 
will then be in the Scheduled Listings filter in the Monitor Listings 
window. 

���"�(����� �

You may find the use of item folders handy for organization purposes. Some Blackthorne users create folders for particular 
products, others for days to list certain items. Others who have multiple people working on Blackthorne may have each lister 
enter his creations into his own folder. An item record may only appear in one folder below the All Items folder, but all item 
records will also appear in the All Items folder. 

To create a folder, right-click on All Items or a sub-folder under which you want the new folder to appear. Click to Create new 
folder. You may then move items to another folder by dragging the grid row(s) via the thumbnail into the other folder or bulk 
changing the folder name for one or more records. 

���"�)	 � �

Item lists are references to item records, while Item folders hold the record themselves. One way some Blackthorne users 
utilize Item lists is to have lists for each day of the week and within each list are items the seller will list on the particular day of 
the Item list. Please search for “using lists to organize your items” in the Blackthorne User’s Guide (F1 in Blackthorne) for 
additional info. 

���"�(	���� �

Please see Chapter 5, Filters. 
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Thru the monitor listings window, you can keep track of scheduled or running listings, revise 
running listings, relist items, submit similar items and other information. 

On the sidebar on the left, you’ll see the various listing status filter. These are: 

·  All Listings – all of the listings, past & present, captured by Blackthorne 

·  Scheduled on eBay – those listings you’ve submitted to eBay to begin at a 
particular date & time (These cost 10¢ to schedule.) 

·  Scheduled by Blackthorne – those listings you’ve scheduled Blackthorne to begin 
at a particular date & time. There is no fee for this, but your computer must be on 
(not in hibernation mode), Blackthorne must be running & you must be connected 
to the internet at the scheduled time 

·  Running – First Run – current listings which are considered “first run” by eBay, such 
as the first time you’ve listed them or resubmissions you’ve made 

·  Running – Relisted – current auction listings you’ve relisted and will receive credit 
on your listing fees if sold during this auction period 

·  Running – Second Chance Offered – current second chance offered listings which are still open 

·  Relistable – No Bids – recently ended auction listings which qualify for the listing fee credit if sold upon relist 

·  Relist – Reserve Not Met – recently ended auction listings which had a reserve price and which qualify for the listing 
fee credit if sold upon relist 

·  Relist – Fixed Price Sold – You may relist these (no crediting of fees) to retain the standing of these items in the Best 
Match search 

·  Completed Listings – As described by titles of sub-filters 

 

You may view any of the above group of listings by clicking on the appropriate filter 
above. In addition, in the Monitor Listings window, you can revise running & 
‘scheduled by Blackthorne’ listings, bulk change running & ‘scheduled by 
Blackthorne’ listings and relist or resubmit listings and make second chance offers as 
well as view your listings thru your browser.  

  

The image above of the top/right view of this window and the image to the right 
showing the Listing Actions identify the various things you can do with your listings in 
this window. Once you click on the action you wish to perform, the pop-up window 
which appears should be obvious as to what you do. 

�

�

�
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To revise a running listing, it first must be allowed to be revised 
according to eBay’s rules. If your listing has had a bid or sales or is in 
its last 12 hours, you are not allowed to revise it. This eBay Help 
page describes changes you may and may not make: 
http://pages.ebay.com/help/sell/edit_listing.html. (If revisions are not allowed, you may be able to Add to Description  by 
choosing that from the Listing Actions menu.) 

To revise a running listing, select it in the grid or details section, then click on Revise  at the top/right of the Blackthorne 
Monitor Listings window. This will open a details editing window as to the right.  

Make the changes you wish, then you can click the Preview  button to the right of the Description field if you want to see how 
your listing will look. 

Do make your choice to “Apply changes…” at the bottom left of this revision window: 

 

If you choose to apply changes to all future listings of that item, those changes will be made to its item record.  

������������%���	���)	 �	�� �

To bulk edit one or more fields of multiple listings, click on Bulk Change 
near the top/right of the Listings window. Enter your change(s) as 
appropriate and check the Apply changes… box at the bottom/left of this 
pop-up window if you choose. Click the Assign  button to make the 
change(s) to your selected listings. (Be aware if eBay does not allow 
one or more of those selected listings to be changed, your changes will 
not appear on eBay.) 

%��	 ��)	 �	���

Relist is considered by eBay and Blackthorne to be those 
auction listings which did not sell and are eligible for 
credit of the listing fees if sold upon a relist. Such eligible 
records are in the Relistable-No Bids and Relistable-
Reserve Not Met filters. To relist, select your record(s) 
and then click Relist  near the top/right of the Listings 
window. A pop-up window will appear on which you can 
make any revisions you wish to make. Choose whether to 
apply the changes to just this listing or all future listings, 
then click the Relist  or Relist  All  button (depending on 
whether you’re relisting one or more listings) to open the 
submission window. 

%�� ��"	��)	 �	���

Resubmitting a listing can be done with any current or 
past listing records. To resubmit a listing, click on the 
Submit Again  link at the top/right of the Blackthorne 
window.  Clicking on Submit Again  will open a pop-up window in which you can edit any fields of info. Choose whether to 
apply the changes to just this listing or all future listings, then click the Submit Again  or Submit  All  button (depending on 
whether you’re relisting one or more listings) to open the submission window 

.  
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In the Finalize Sales window, you can perform a variety of actions, from tracking sales and unsold items, to keeping on top of 
payments and shipments, sending emails to your buyers, tracking consignment information, leave feedback, file and manage 
unpaid item disputes to generating reports. 

Each seller will have his own system for handling sales, I describe my own process here. 

.���
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When Blackthorne does its behind-the-scenes refresh or you refresh activity, any new sales since the previous refresh will 
appear in the sales window. If the buyer has not yet paid with PayPal, this record appears in the Ready for payment request  
filter. If it has been paid for, it will be in one of the payment filters within the Paid filter. 


��� �
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To the right is an image of the various sales statuses. These mean: 

·  Ready for payment request – A sale has been made but payment has not yet been 
received. Many Blackthorne users send the “First Notification” email to the buyer 
when in this status. 

·  Payment request sent – A “First Notification” email has been sent to the buyer. That 
email template has been marked to change the sales status to “Payment request 
sent” when that occurred. 

·  Payment request replied – This is a status which can be chosen by the Blackthorne 
user when the notification has received a response. 

·  Second payment request sent – Often used when a reminder for payment has been 
sent to the buyer. (Email template can cause this status to be toggled when the 
“Second Notification” email is sent.) 

·  Final payment request sent – Some Blackthorne users will send the “Final 
Notification” email to give one last chance for the buyer to make payment prior to an 
Unpaid Item Dispute being filed. 

·  Past due – This is a status you can manually change to – or you can have one of 
your email templates trigger to this status. 

·  Payment on hold – Blackthorne marks a sales record with this status if, for example, 
the buyer pays a different amount than is what Blackthorne shows it should be. You may also choose this status if 
you received a personal check and will not ship until the payment clears. 

·  Payment received – Blackthorne marks a sales record with this status when a PayPal e-check has been received. 
When the payment clears, Blackthorne will then change this status. You may also choose this status if you received a 
personal check and will not ship until the payment clears. 

·  Payment cleared – When a cleared PayPal payment is received, Blackthorne will change your sales record to this 
status. You may also manually set this status if you’ve received a direct credit card or other payment which is cleared. 

·  Ready to ship – This is a status you can set yourself or thru an email acknowledging your receipt of the cleared 
payment. 

·  Shipped - This is a status you can set yourself or thru an email acknowledging you’ve shipped the package. 

·  Successful – You can have Blackthorne mark a record as successful (completed) when you send feedback if you 
wish. (Do this under Tools>Options>Feedback presets.) Or you can mark it yourself, which, for example, if you use 
another program to leave feedback automatically, you may want to do. To me, this means everything having to do 
with a particular transaction is over & done with. 

·  Reimbursed – If you filed an Unpaid Item Dispute, when eBay credits your final value fees, Blackthorne will change 
that sales record’s status to this, meaning your fees were reimbursed by eBay. 

·  Unsold – Blackthorne does create an “Unsold” sales record so your sales fees are still recorded. 

·  Unpaid – If you refunded a buyer his payment and/or he didn’t pay and you did not file an UID to get your fees 
credited, you’ll mark the sale as unpaid. 
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 On the left side of the BTPro window are the Views. You may use 
the default BTPro filters or create your own. For example, if I want to 
see all my auction items which include the word “book” in the title and 
the starting price was less than $20, Right click on the Item Filters 
folder to create a new filter, then add the conditions for this.  

 
 
The image to the right shows the conditions as just described. When 
I close the filter create/edit window, it takes just a few moments for all 
records meeting the set conditions to be included in the new filter. I 
generally name the filters so I can see at a glance what they are for. 
You can name your filter in the Name: field as in the above screen 
shot or by right-clicking on the filter, then selecting Rename Filter . 
This allows you to type the filter’s name in the left sidebar. You may set a grid view for each filter on the Columns tab of the 
filter edit window. 
 
Please note: on the Views in the left sidebar, there 
are more options under those which have a + 
before the folder name. BTW, by dragging your 
filters up or down in the list in the sidebar, you can 
place them in your preferred order. 
 
One of the handiest filters I created for keeping my 
in-process sales organized, I named “Outstanding 
Sales”. In the Name field, enter the name of your 
filter. Add the conditions which must be met; in this case, I want to see all sales for which the status is less than Successful 
(items which need payment, to be shipped or to leave feedback). On the Columns tab, create a Column Set showing the fields 
you’d like to see for this filter. I show: 
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You may create custom grids to view your items in a way that makes sense to you. There are many BTPro default grids, but 
you will likely find you want to rearrange, delete or add fields to these. To create, for example, a new grid view for the All Items 
folder, click on the Customize link near the top/right of the BTPro window when you have the All Items folder selected. This 
opens up a “Customize View” window to the Columns tab. 

 

 I select one of the default “Column Sets” as a start, then click the Duplicate Column Set..  button and name the new 
grid/column set I’ll be creating. Click a button (or Ctrl+click multiple) in the right/Columns window for each field you do not want 
to see in your grid and click the Remove  button. To add fields from the left/Available Fields window, select them then click the 
Add  button to move them into your grid. 

When I have only the fields I wish to see in the grid in the Columns window, I move to the order I want by dragging the field 
name or selecting the field then clicking on the Move Up or Move Down button. Click OK on the Customize View window when 
it’s as you want. Your grid will then be set to this view. If you need to make one column wider or narrower, do this by clicking 
on the top of the grid between the column names and drag it as you wish. You can make the grid rows taller by clicking on the 
divider line just to the left of your grid, then dragging it to be taller. Then, click customize, save the column set under the same 
name (click OK to overwrite) and click OK on the Customize View window. 
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You can bulk change item records, listing records or sales records.  

In the items window, there is a bulk change button near the top/middle-right of the Blackthorne window. Bulk change is also 
available under the Items Actions menu.  You may apply one or more conditions to bulk change your selected records. A 
typical bulk change done to item records is to remove text from your descriptions, such as when eBay removed “money orders 
and personal checks” as acceptable payment methods to note in your listings. In this case, I first created a filter which had the 
phrase – money orders – in the description field and looked at the first item record to copy the exact phrase  which I wanted to 
delete. I then selected all of the records in that filter and replaced that phrase with nothing: 

 

(Notice you’ll only see the last word or two of that sentence/phrase in the Value field. Do not enter anything in the last field in 
this circumstance.) 

After replacing that phrase, you may find “money order” still appears in additional item records. Find & copy the next such 
phrase & replace that. (I’ve seen as many as 30 different ways one seller had mentioned money orders & personal checks in 
his descriptions!) Then, customize that filter with the phrase personal checks to see if that appears. This is a tedious process, 
but when eBay tells us we can no longer mention something, we have to remove it! 

Of course, you could replace the phrase with another. The description bulk change also allows you to change the whole 
description to the Value you enter, Append (add something to the end of the description) or Prepend (add something to the 
beginning of the description): 

 

 

Many other fields in the bulk change window behave similarly. 

Notice the variety of changes you can make to the cost or price fields: 

 

Some fields may be changed to True (if checked), such as this: 

 

You can also make a two or more changes at one time. (But, you cannot change two separate phrases in the description field 
at one time.) For example,  

You may also bulk change Item Specifics, by selecting a group of item which use the same Item Specifics, then going to 
Listing Actions>Bulk Change Item Specifics. 
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Bulk changing running listings is a bit different – there is a button near the top/middle-right of the Monitor Listings windows and 
also under the Listing Actions menu. Notice the check box at the bottom/left of this bulk change window – by checking that 
box, your item records will be updated when your eBay listings are. Also, note the Assign  button – clicking this means you 
want to revise all the running listings selected with this information.  

 

BULK CHANGE – item condition 

 

 

In the Finalize Sales window, you get to the Bulk Change feature under the Sales Actions menu. To quickly change the sales 
status of a group of records, you can click on the Update Status link near the top/middle-right of the Sales window. 

If you’re not quite sure about how to bulk change a particular field, please ask on the Blackthorne-hosted discussion board. 
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The Ad Templates can be as simple or detailed as you wish. This section will take you through the 
creation of a custom Ad Template. I recommend you create this sample to learn how to create and 
modify your Ad Templates, whether you will use one of BTPro’s many templates or create your 
own. (Please see http://forums.ebay.com/db2/thread.jspa?threadID=1000119156 for an eBay 
workshop I presented on this topic in Blackthorne’s early existence.) 

(If you already have a template you’d like to use in Blackthorne, please see either or both of these 
tutorials for information: http://www.going1nce.com/convertat.html or 
http://www.going1nce.com/sample/dwtobttemplate.pdf .) 

For this practice, it is assumed you will be using the logo I have at 
http://www.going1nce.com/yourlogo.jpg. Go to that web page, right-click on the image and “Save picture as” yourlogo.jpg to 
the folder in which you keep your eBay pictures. 

Create a new item record, such as described in Chapter 2. In the Theme field (None)  should be selected. Select Manage Ad 
Templates  in the Ad Template (AT) field. This opens the Ad Template preset window. Select Simple , then click on the 
Duplicate  button. Name your new AT MyATTest. Click Done to return to the item window. Make sure you’re on the correct 
item record, then click on the Edit  button to the right of the Ad Template field to open the AT Studio. It opens to the Design 
tab, with only the variable [[Description]] on it.  

During this section you will want to refer to the AT Toolbar section beginning on page 44. So – when I tell 
you to click on the table icon, for example, you’ll know which one it is. 

 

eBay does not allow revisions to running auctions which have received a bid (even if you cancelled bids) or 
to some fixed price listings. To find running listings which still include that which you attempted to change, 
first refresh your running listings (BTPro edits your records in Blackthorne prior to doing so on eBay, so 
until you refresh, it will appear your changes all occurred.) Next, create a listing filter to show all your 

running listings which do not include the change you made. 

If you want to make the changes to the records for which it was not allowed, select these listings and Go To their item 
records. I then bulk change a field such as Notes or Storage Location with a word that will easily let me find those item 
records again if needed. I then go back to those listings and end them early on eBay (under the Listing Actions menu), then 
go to their item records, make the changes via bulk change and list them again. 
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Let’s first create a table 800 pixels wide in which to place your template so that it will be easy for visitors to read (If your 
template is wider than this, you should create tables within this table so that the description text, for example, isn’t too wide to 
easily read.). To do this, first put your cursor before [[Description]] and click your Enter key. Place your cursor at the top/left of 
the Design window, then click on the table button (See all the formatting buttons below) to open the table properties window. 
Enter the following info as shown to right: 

In the Table Properties window as shown to the right, select 1 for the border, click the Pixels  radio button, then enter 800 for 
the width. In Cell Properties, select 1 row and 1 column and 0 cell padding and 0 cell spacing. Click OK. This will place a table 
at the top of the AT Studio Design window. 

Put your cursor inside the table cell, then click on the Image (camera) button at the top of the AT Studio window. This opens a 
small window, as in image to left. In the URL field of this window, enter the url for the sample logo -  
going1nce.com/yourlogo.jpg. Click OK. If you are connected to the internet, the logo should appear. It is selected, as you can 
tell by the handles on each side and corner. Click to the right of the logo then click on the center formatting icon to center the 
logo. Click your Enter key to move your cursor down. 

On the right side of the AT Studio window, under Item Fields, select Title , then click the <Insert Field  button to place the 
[[Title]] variable. Let’s make the title big, bold & blue in Lucinda Console. (Please use one of Windows’ standard fonts. If you 
use a font that isn’t loaded onto the viewer’s computer, the look of your listing will 
not be as you expect. As it is, most Macintosh users will not see your designated 
fonts.) Highlight/select [[Title]] and click on the font icon. This opens the window to 
right. Select Lucinda Console and size 24. Click OK to continue. While [[Title]] is 
still highlighted, click on the B icon to apply bold. Click on the font icon (palette) 
and select the blue square to apply blue to your title.  Click OK. 

Place your cursor to the right of [[Title]] and click your Enter key. Select & insert 
Subtitle  from the Item field (as you did above when you selected [[Title]]). 
Highlight [[Subtitle]] and apply the font Arial, size 18 to it. Also click on the I icon to 
apply italics to it. Place your cursor to the right of [[Subtitle]] and click your Enter 
key. 

Highlight [[Description]] and drag it into the table under [[Subtitle]], as you can drag 
blocks of text in MS Word. This will be placed on the left rather than centered. Leave it so. (It’s easier to read a block of text 
that’s left-justified rather than centered.) Highlight [[Description]] and apply the font Arial, size 12 to it. Place your cursor to the 
right of [[Description]] and click your Enter key. 

From Item Fields, select Picture 1, insert into Design View window, click a space, then select Picture 2 & insert into Design 
View window. Click on the center icon to center these pictures next to each other. (If your 2 pictures are wider than a total of 
800 pixels, they will stack in the center rather than be side by side. Place your cursor to the right of [[Picture2]] and click your 
Enter key. This is how things should look at this point: 

 

Now, let’s add Global AutoText (GAT) to this. (See additional information about Global Auto Text in the next section.)  We’ll 

create one for our Terms of Service. The GATs are a handy thing – if, for example, you have 10 different ad templates which 
includes your terms, you only have to edit it once and it will apply to all of your templates which have your global TOS variable.  



 43 

To create this TOS, click on the Edit Auto Text  button. (You must do this from the Design View of the Ad Template Studio.) 
Click on NEW at the top of the mini-window which opens. Name this TOS.  

Click the Edit  button to open a window in which you can create your TOS similarly to creating an Ad Template. (See following 
section, Global Auto Text.) 

You will now insert a table which has the properties: border 1; alignment 
center, width 300 pixels, 3 rows, 2 columns, 1 cell padding and 4 cell 
spacing. Click OK. (We’re using this table to note our Terms of Service so 
we can use the html which is generated by the AT Studio.) In the top left 
cell, enter the text PAYMENTS. In the 2nd left cell, type REFUNDS. In the 
3rd left cell, type OTHER. To each of these words, apply bold, red 
formatting in Lucinda Console, size 10. 

In the top right cell, type We accept paypal,only. In the middle right cell, type 
We do not accept returns. All items are sold AS IS, so please ask questions prior 
to bidding. In the bottom right cell, type We welcome new bidders. Please 
email us with any questions. Apply Arial, size 10, black to the text of the right 
cells. This should look like the image below. 

 

Click OK to close that window, then OK to close the Edit Auto Text window. In the Ad Template design view, your cursor 
should be placed on a blank line at the bottom, just inside the table border. Under “Global Auto Text” at the right side of the AT 
Studio window, select TOS and click <Insert Auto Text  to place the variable, [[TOS]] into your template. 

Your AT Studio preview window should look like this: 

 

 

Click on the Options tab at the bottom of the AT Studio window. Select Manual  for Image Placement, Original Width  for 
Image Width and Retro Computer Style  for Counter. (If you use one of BTPro’s themes, you may choose any image layout 
you prefer.) 

Click on the Preview tab at the bottom of the AT Studio window. Your preview will show the actual title, subtitle (if you used 

one) and uploaded photos of the item you have used while creating this Ad Template.  If you have no title, subtitle or 

description with this item, you may close. Click OK at the bottom/right of  the AT Studio window and select another item record 

to view this MyATTest template with. (By the way, if you have only one image for this item, you will not see anything where 

[[Picture2]] was in the design view. Similarly, if you have no sub-title, that variable will not show in the preview.) That’s it. Okay, 

I know this section went on & on, but I wanted you to get an idea of just what you can do with your templates. (Even if you 

know html, you must admit the BTPro AT Studio is one heck of a useful tool!) Here’s what this finished Ad Template looks like 

with a title, subtitle, description & 2 photos: 
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You have double pictures on your listings, the ones  you added to your Ad Template (AT) & the same at t he top, side 

or bottom?  On the Options tab of the AT, change the Image Layout to Manual. 

Don’t use all the GATs included by Blackthorne?  You can delete any you wish, but it’s possible you may later wish for just 

that one GAT – keep ‘em! 

NOTE: If your Ad Template uses CSS, that CSS code must be placed within a GAT.  

�
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At http://www.going1nce.com/convertat.html, I have instructions for converting the template you used prior to Blackthorne. 
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This feature is one of the ones I really like! Global AutoText (GAT) can be used in the Ad Templates and Descriptions.  GATs 

are variables created through the Design View of the AT Studio. To create a GAT entry, within the AT Studio, on the right side 

of the Design view, under Global Auto Text, click on the Edit Auto Text…  button. This opens a small Edit Auto Text window.  

Click on the New… button to open a mini-window in which you name your new Auto Text variable. For example, if you want 

one that says “I am the most wonderful eBay seller there is!”, you might name it “Most”. Click OK after you’ve named the GAT 

variable you’re creating. Then enter the “I am the most…” text into the larger field of the Edit Auto Text window. You may 

double-click in the GAT editing field to open the GAT designer, similar to that of the description editing and Ad Template 

design windows. Click OK to return to the Design View of the AT Studio and close that if you’re done creating GATs. Your 

variable is now [[Most]]. If you enter this variable into your AT or Description, the “I am the most…” text will replace the variable 

in the previews and your listing.  

GATs are also available in Email Templates. 
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The GATs are a handy thing – if, for example, you have 10 different ad templates which includes your terms, you only have 

to edit the terms GAT once and it will apply to all of your templates which have your global TOS variable. We’ll use the AT 

Studio formatting functions to create a table from which we will use the html code for the global TOS. GATs are also used to 

hold CSS and Javascript. 

0&���������

These are the tools used in the AT Studio and Description edit window: 

 

Cut – This deletes selected text. Ctrl+X will do the same. 

 

Copy – This copies selected text. Ctrl+C will do the same. 

 

Paste – This pastes text from your clip board. Ctrl+V will do the same. 

 

Undo Typing – This deletes the last text you entered or formatting you applied. Ctrl+Z does 
the same. You may do this multiple times to delete the last change, the 2nd to the last and 
so on. 

 

Redo Typing – This restores that which you just undid. Ctrl+Y does the same. You may do 
this multiple times to restore the last undo, the 2nd to the last and so on. 

 

Bold – Applies bold to the selected text. 

 

Italic – Applies italics to the selected text. 

 

Underline – Applies underline to the selected text. 

 

Font – Choose font, size and effects here. (Please use standard fonts. If you choose, ABC 
Fancy Font, for example, which you have on your computer, most viewers will not have 
that font installed and will see whatever default font their computer uses. To use fonts 
others may not have, it’s best to create a jpg or gif of your text.) 
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Remove Formatting – Will eliminate all formatting from selected text. 

 

Modify Font Color – This brings up a palette of colors which you can apply to selected text. 

 

Increase Font Size – Each click of this icon will increase the size of your selected text to 
these sizes: 8, 10, 12, 14, 18, 24, and 36. 

 

Decrease Font Size - Each click of this icon will decrease the size of your selected text to 
these sizes: 8, 10, 12, 14, 18, 24, and 36. 

 

Left Justify – This aligns your selected text to the left. 

 

Center – This centers your selected text. 

 

Right Justify – This aligns your selected text to the right. 

 

Indent – This indents your selected text, similar to tabbing. By selecting a block of text & 
applying Indent to it, this section would look something like this: 

Indent – This indents your selected text, similar to tabbing. By selecting a block of text & 
applying Indent to it, this section would look something like this. 

 

Outdent – This reduces the indent. 

 

Toggle Ordered List - This applies numbers to the selected text, such as: 

line one info 

line two info  

line three info 
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Toggle Unordered List – This applies bulleting to the selected text, such as: 

line one info 

line two info  

line three info 

 

Insert Horizontal Line – Inserts a horizontal line where your cursor is placed. 

 

Insert Table – Inserts a table into your Description or Ad Template Studio design window.  

 

Insert Image – Inserts image from your web space. You enter the URL of that image. If this 
template is for items from the XYZ Company, you may wish to insert the company logo with 
this. 

 

Find & Replace Text – This replaces text within the description. If, for example, you typed 
XYZ several times, then realized it should be ABC, you can replace the text with this. 

�

�
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At Tools>Options>Email Templates, you can 

modify the BTPro email templates, duplicate or 

add new ones. I duplicated “Received Payment 

Notification”, named it “Thanks Payment” and 

modified it to look like this in the design view of 

the Email Studio: I advise duplicating your email 

templates and modifying the dupe so you will have 

the originals if needed at a later time. 
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Under Fields, at the right/top of the email template window, your correspondence variables are selected. Since I use my part 

number for many things, I included it through it’s variable, [[PartNum]]. I also used a couple other variables I wanted in this 

email template, as seen in photo. The text I wanted to change from the original template, I just highlighted and replaced with 

the text I wanted. I also created a Global Auto Text called “sig” to place at the end of the email. The edited text in the Global 

Auto Text editing field looks like this: 

Thanks,<br/>  

Sally Milo<br/>  

GOing 1nceLLC<br/>  

www.GOing1nce.com  

I applied text formatting, Arial, 12 pt., by selecting all the text and using the A formatting tool at the top of the window. By the 

way, if you click the Enter  key, it will put a paragraph break in the text. Clicking the Enter  key while holding the Shift  key will 

place a simple line break. 

Email preview: 
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You cannot customize the layout size of a Packing List (PL) and most of the default Blackthorne reports. In this section, I will 

explain how to modify a Packing List, info which applies generally to the other reports. 

To open the Print Studio, go to Tools>Options>Printing Templates. Choose Packing List . You can use the PL as is, or can 

add your own info and arrange as you wish. (If you wish to preview a PL for a specific record(s), select the record(s) in your 

Sales screen, then to the Print Studio. 

The image below shows the design window for my packing list, 

 

These are the steps I used to modify the PL to my preferences: 

Delete the info above the "Qty. Title..." line EXCEPT those for the date, Buyer, eBayUserid, Email and both for Buyer ID.  

To add logo: 

Click on tool on left that is a box with colors in it (tool above empty box as seen to left) 

Draw square at upper left for logo  

Click on the newly-drawn square  

On bottom right of window are properties  

Under "Data" section of properties, click on blank field to right of "Image"  

Click on "..." icon to open browser, go to your logo on your computer and select it.  

It will be placed in the drawn box, but will likely need to be sized and made to fit.  

To fit within the drawn box, in the properties, under "Layout", go to field to right of "SizeMode". Select "Zoom".  

You can now drag the handles of the drawn box to adjust size & shape for logo  

(To put larger logo at right, I copied the one I drew on the left (Ctrl+C) and pasted it (Ctrl+V) and dragged it to the location at 

right. I then resized it larger.)  
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To add return address to right of logo: 

In Fields section on right side of window, select ReturnAddress . Drag it to the area you wish the return address to be placed. 

(This return address is pulled from the Seller Account information in your settings.)  

To edit the font size, color, etc., under Properties "Appearance", select the field to the right of font to adjust font, type & size. 

Select the color in the field to the right of "ForeColor ".  

Click on the Preview tab at bottom left of window to check your return address text box is sized correctly. Return to Design 

View and modify as needed.  

To add text for "ship to" headline:  

Click on text tool - Aa  

Draw box where you want this text to go  

On properties, under "Data" is "Text". To its right will be "LabelXX ". Highlight "LabelXX ".  

Type in whatever you wish, such as Ship To:  

To edit the font size, color, etc., under Properties "Appearance", select the field to the right of font to adjust font, type & size. 

Select the color in the field to the right of "ForeColor ".  

To add lines for design elements: 

Select the line (\) tool. Click at the starting point, drag to the end point, then release mouse click.  

To edit the line width, style & color, in Properties, select the field to the right of LineColor , LineStyle  and LineWeight  and edit 

to your preference.  

To add part number: 

On right side of window, under Fields>Bound, select PartNum  and drag it to the space you wish it to appear. You may adjust 

its size, font, etc. through the properties section.  

You can similarly add other fields you wish, such as Notes . You may wish to add StorageLocation  in the Detail section, as 

that will aid in pulling your items if you use that field.  

To add other text: 

Click on text tool - Aa  

Draw box where you want this text to go  

On properties, under "Data" is "Text". To its right will be "LabelXX ". Highlight "LabelXX ".  

Type in whatever you wish, such as Thank you for your purchase!  

To edit the font size, color, etc., under Properties "Appearance", select the field to the right of font to adjust font, type & size. 

Select the color in the field to the right of "ForeColor ".  

In the middle/Detail section, I deleted info I do not want on my packing list. On the Group Footer section, I added 2 blocks of 

text I want to appear on my PL.  

This shows how my packing list will look when printed: 
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(The reason I have the return & buyer’s addresses in the top 

left is that I fold my PL printed side out into thirds and thirds 

again. I then place it in a PL clear envelope and stick it on the 

outside of the package. This way I don’t have to print a 

shipping label also.) 

 

�
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Many Blackthorne users who have their products in a spreadsheet or database have discovered importing a flat file a useful 
thing. If you have your products in Excel, a database or another program which you can save or export as a CSV file, you can 
easily import that data into Blackthorne. If you export a sample Blackthorne CSV file (under File>Export), you’ll discover about 
200 fields are in the Blackthorne database which can be imported & exported – but many of these are not used by most 
sellers.  

Imagine your CSV file looks like this: 

 

You want to import that data into Blackthorne? Here’s how: 

Go to File>Import>Import from Flat File as shown to right. Browse to & select your 
CSV file as below. (That file can NOT be opened in Excel or other program or it will 
cause an error and not let you import it.) 

 

 

The window to the right opens. If your columns are 
the same name as the Blackthorne field, you’ll see 
them in the CSV field column at the bottom of this 
Import window. If your column name is not the same 
as the BTPro field, you’ll drag the column header, 
such as Photo 1 in the following image to the Picture 
1 Blackthorne Field: 
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�

Do the same for the other fields as needed. (One check I do is count my columns across the top and compare to the number 
of fields I have marked in the CSV Field column.) 

When you have each of your CSV fields mapped to the appropriate Blackthorne fields, click on the Save button to save the 
map so it’s available next time you need to do a similar import. Also, you should select an Item Template so that your most 
frequently used fields, such as shipping preset, payment preset, ad template, etc. will be included in the record. 

�
Click the Import  button and after processing, you’ll see your imported item records in the New & Unlisted filter in the Create 
Items window. 

Before doing a full import of all of your records, I recommend importing 2-5 of those records 
to make sure all data comes in as expected.  

�
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If your supplier provides you with a spreadsheet on a regular basis with price or other changes or if you create changes in your 
own spreadsheet, you can update your records in Blackthorne to reflect such changes from a CSV file. In the Blackthorne 
User’s Guide (F1 key in BT), search for the phrase Updating from a flat file – choose the result, Importing Data, & see the 
Updating… section near the bottom of that page.  
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You may select records to export to an Excel file as in image to 
right,  I selected four records in one of my sales filters.. I then 
went to File>Export to Excel. This opens a mini-window as 
below. 
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If you don’t want to save the file to the location shown, click on the Browse button to the location you want. You may change 
the default file name to one that makes sense to you. Select one of the choices in this window: Export selected Items in the 
grid , Export all Items in the grid  or Export all Items . (If you export all items, all of your records in the folder or filter you’re in 
will be exported.) You may check the box to Display file in Excel when complete . Click OK to begin the export, then fiddle 
with your file in Excel as you wish. 

 

 Blackthorne exports all fields to Excel as text fields, so you’ll have to convert numerical 
columns and dates to their appropriate formats to manipulate such data.  



)������� ���

By default, Blackthorne runs with an Access database. (You do not need to 
have Access to run it.) If your database is running fine, you could just leave it 
as is – BUT, if you have multiple computers on which Blackthorne is used in a 
network or many records or things appear unstable, I recommend switching 
to a SQL database. Search on sql in the Blackthorne User’s Guide and follow 
the instructions in the HOWTO results as shown to the right. It may take you 
an hour or two to download & install SQL on your computer and to convert 
your database to a SQL db, but once you do so (by following the 
instructions!), you’ll be rewarded with a bit more speed & stability! 
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Don’t want to read the fifty-some previous pages YET? I most strongly ADVISE doing so – but, I know some of you just want 
to jump right in. Okay, okay – we’ll assume you’ve downloaded & installed Blackthorne, went thru the set up process as 
described in Chapter 1 – BUT – you really, really should spend some time going thru this whole guide soon to use Blackthorne 
most optimally! 

From the Create Items tab, go to New Item>Untitled near top of the Blackthorne window as seen in below image. 

 

 

Click OK to create one new item. 

 

 

You’ll then enter data to each section as pictured then described below. 
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A. Title 

B. Format & Pricing – select auction or fixed price and the duration, the starting, buy it now &/or fixed price. 

C. Listing Upgrades – choose the upgrade you want or click the Edit  button to the right of this field to select other(s) 

D. Payment – Click the Edit button to enter your payment and returns information. If you expect this will be what you’ll be 
using for future listings, I suggest you click the checkbox at the bottom left of this edit window to save it as a preset. 
This setting is described in Chapter 1>Settings>Presets>Payment Preset. 

E. Contact – Choose to Manage Contact Accounts & create New as described in Chapter 
1>Settings>Accounts>Contact Account 

F. Pictures – Click on the picture well(s) to choose the photo(s) from your computer you want on your listing – or enter 
the picture’s URL in the field.  

G. Description – Enter your description into this field or click on the Edit  button to the right to open the WYSIWYG 
description editor to apply formatting to your description. 

H. Shipping – Click the Edit  button to the right of this field to enter your shipping and handling time data. If this is a 
setting you expect to use in the future, check the “Create Preset...” box at the bottom/left of this window. 

I. Theme / Ad Template – eBay provides basic listing frames known as themes to Blackthorne subscribers at no charge 
– 10¢ per listing for non-subscribed IDs. The Simple or Enhanced Ad Template is the layout of items within the frame 
(or without a frame). 

J. Category – This is the eBay category under which your item will be listed – or two categories, if you choose to pay 
double the listing fees. Click the Select  button to the right to choose your complete category path. If that category 
supports Item Specifics or Multi-Variations, a blue ball and Next button will appear in the category selector window. 
Click that Next  button to enter that information. 

K. Store Category – If you have an eBay store, select the appropriate store category(ies) you wish your item to appear 
in. (If your store cats. aren’t showing, go to Refresh>Update Seller Account Information to see them. – This takes a 
few minutes.) 

After completing this information on your item record, I suggest clicking the Preview button near the top/right of the 
Blackthorne window so you can check it prior to submitting. Then, click the Submit link at the top/right to submit your listing to 
eBay immediately. If it goes thru, you’ve done all right – and that item record will not be in the New and Unlisted filter. If there 
was a problem, you’ll see a yellow bar with some error text above the item details. 

 

 

 


